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List of changes made to Larson Davis G4 LD Utility software1 

G4 LD Utility Version 5.3.5 June 2025 

Fixed 

1. Bluetooth Devices were not being detected – The Bluetooth component in G4 failed to start 

properly so no Bluetooth connected devices would show up in G4. This only affect 5.3.4 and has 

been resolved in G4 version 5.3.5. 

G4 LD Utility Version 5.3.4 June 2025 

New 

2. Sound Recording Gain for the 721/821 – The 1.502 version of 721/821 firmware allows applying 

a gain to the Sound Records, G4 5.3.4 supports configuring the related settings. 

Issues Fixed 

3. X21 files missing Room Acoustics sheet – Files containing Room Acoustics data were previously 

missing the Room Acoustics sheet. Going forward, all files that have Room Acoustics enabled 

and contain at least one measurement (NC, RC, or NR) will include the Room Acoustics sheet. 

4. X21 Room Acoustics settings missing from Settings sheet of Files – Room Acoustics settings 

were not included in X21 files. They can now be found in the Settings sheet in the Overall 

Settings section. 

5. X21 Custom Report issue with Room Acoustics settings – Files created with at least one Room 

Acoustics measurement being disabled prevented Room Acoustic data from being included in 

the Custom Report. Custom Report checkboxes were also visible for disabled Room Acoustics 

measurements. Reports now show Room Acoustics data and the Custom Report checkboxes are 

displayed accordingly. 

6. AudCal Pulse test tabular view caused display issues – While in an AudCal Pulse Test Results 

view, checking Show Table and navigating to another test would cause the graph to show above 

the table. This has been fixed to only show the table when the Show Table checkbox is checked. 

7. AudCal Narrowband Noise Test missing Max values – AudCal Narrowband Noise Test results 

weren’t displaying the Max values due to an internal issue. This would result in empty cells 

under the Max column in the results tabular view, and NaN for Max values in the Report. The 

data is now being retrieved and displayed correctly in both places. 

G4 LD Utility Version 5.3.3 June 2025 

Improved 

1. 831C Time History Graph tool tip visibility improved – Tooltip text from data points on the Time 

History graph could be obscured by overlapping metric labels. G4 has improved the layering 

logic, ensuring tooltips remain readable. 

 
1 

Note: Numbers in parenthesis such as “(3210)” are an internal tracking number. Test Track Items will be prefaced with TT.  
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Issues Fixed 

2. 831C Session Log entries not showing sound recordings – When both Measurement History and 

Exceedance Sound Record options are disabled and a marker is used to trigger a sound 

recording, the sound record link does not appear in the session log. The sound recording link 

now shows correctly in the G4 session log. 

3. X21 Tools “About” window fields blank on first open – was After connecting to a 721 or 821 

meter and then navigating to Tools -> About the data is not populated until after the About 

screen has been closed and reopened.  

4. AudCal OSHA Booth tests were not using the correct filters – The filters used were 1/3 octave 

filters from the ANSI S3.1 (1999) test specifications rather than the 1/1 octave filters specified by 

OSHA. Because of the dissimilarity, the OSHA and ANSI booth tests have been separated and 

only one can be selected for a single test. The OSHA booth test now uses the correct filters as 

defined in OSHA 29 CFR 1910.95 App D. 

5. AudCal ANSI S3.1 was incorrectly labeled with the wrong date – When selecting  ANSI S3.1 

(1991) for booth test, AudCal applied the ANSI S3.1 (1999) criteria. With this version of G4, 

previous and future booth tests for compliance with the ANSI S3.1 standard will be correctly 

labeled with ANSI S3.1 (1999).  

6. Automatic downloads may not complete – When G4 is opened while files are actively being 

downloaded in the background, the file download is temporarily paused.  A bug that could have 

prevented G4 from resuming a paused download has been fixed. 

7. X21 Live View missing Last Calibration update – After calibrating an X21 meter, the Live View 

panel did not refresh to show the updated calibration date. G4 now updates this information 

immediately after calibration is complete. 

8. Audiometer Calibration due date – When adding a new audiometer configuration in AudCal, 

the calibration due date will now automatically default to one year in the future. 

9. New calibrators added to AudCal – The new Cal1150, Cal1200 & Cal1250 calibrators have been 

added as calibrator options in AudCal. 

G4 LD Utility Version 5.3.2 May 2025 

Issues Fixed 

1. HVM 200 files created or overwritten by G4 could contain errors – Files that contain VDV, 

A8Act, and A8Exp were incorrectly having a unit conversion applied when saved from inside G4. 

This usually only happens when saving a file after adding edit bands or when using the Save As 

menu option. Sometimes this would result in the file no longer being readable by G4. G4 version 

5.3.2 now detects both the issue that prevents it being parsed and the incorrectly applied unit 

conversion and will correct after getting confirmation from the user. 

2. HVM 200 files created using decibel (dB) units were miscalculating the summary metrics – The 

calculations for the Crest Factor and the modified summary’s Arms, Crest Factor, VDV, A1, A2, 

A4, A8, A8Act and A8Exp were assuming linear domain arithmetic but dB is logarithmic and 

requires adjustments to the algorithms to account for this that were not being applied. The 

corrected values will be displayed in the spreadsheet in G4 when opened with version 5.3.2 or 
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later, previously exported spreadsheets will need to be re-exported if the measurement was 

done using dB units. 

3. HVM 200 files created or overwritten by G4 could contain errors – Files that contain VDV, 

A8Act, and A8Exp were incorrectly having a unit conversion applied when saved from inside G4. 

This usually only happens when saving a file after adding edit bands or when using the Save As 

menu option. Sometimes this would result in the file no longer being readable by G4. G4 version 

5.3.2 now detects both the issue that prevents it being parsed and the incorrectly applied unit 

conversion and will correct after getting confirmation from the user. 

4. HVM 200 files created using decibel (dB) units were miscalculating the summary metrics – The 

calculations for the Crest Factor and the modified summary’s Arms, Crest Factor, VDV, A1, A2, 

A4, A8, A8Act and A8Exp were assuming linear domain arithmetic but dB is logarithmic and 

requires adjustments to the algorithms to account for this that were not being applied. The 

corrected values will be displayed in the spreadsheet in G4 when opened with version 5.3.2 or 

later, previously exported spreadsheets will need to be re-exported if the measurement was 

done using dB units. 

5. 721/821 Data File Report “View PDF” or “Email PDF” would fail – The buttons to view or email 

the pdf report caused the button controls to be hidden and never completed the operation with 

either a dialog to save the PDF or the default email client. This has been corrected in G4 version 

5.3.2, the buttons are temporarily hidden while generating the PDFs but are then visible again 

once the operation completes. 

6. Push To Cloud Authorization Auto-Renewal would fail – 831C meters that are configured to 

push to DropBox were failing to auto-renew their authorization after 4 hours of use. This was 

due to G4 supplying incorrect details to the meter. G4 now correctly configures the meter to 

allow it to auto-renew its authorization. 

7. Meter and Project file lists not showing all available files – The meter and project views in G4 

were only showing files that had been downloaded or manually opened by G4, any files that had 

manually been added to the data folders for G4 were not visible until manually opened by 

navigating to it using the Open Data File menu item or in Windows Explorer.  

G4 LD Utility Version 5.3.1 April 2025 

Issues Fixed 

1. 831C Room Acoustics NC and RC file processing – G4 was not creating the Rooms spreadsheet 

tab to display the NC and RC metrics measurement and the graphs were not loading for 831C 

files. The 831C files have correct data and when opened using G4 version 5.3.1 the missing data 

and graphs are displayed. 

2. 831C AudCal Hearing Level Test Levels not saving – When attempting to set the test levels in 

the hearing level test they would revert to the defaults after accepting the updated values. They 

are now preserved correctly in G4 5.3.1. 
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G4 LD Utility Version 5.3.0 March 2025 

New 

1. Support for 721 and 821 Sound Recordings – G4 will now show sound recordings created by 

721 and 821 meters with firmware versions 1.4 and later. The meter can also be configured 

from the meter’s settings page in G4 or directly on the meter. 

2. Support for CAL 1150, 1200, and 1250 Calibrators – G4 will show connected 1150, 1200, and 

1250 calibrators allowing the user to view current status and update the calibrators firmware 

when needed. 

3. Support for the 721SE and 821SE Room Acoustics Noise Rating Measurement added – The 

Room Acoustics feature of the 721SE and 821SE has been expanded in firmware version 1.500 

to include the Noise Rating metrics and curve. G4 will shows these metrics when communicating 

with a meter that supports this feature and has firmware version 1.500 and will show these 

values in the file views and reports if enabled in the file. 

Improved 

4. 730, 721, 821, and 831 meters how show the sound record duration in the session log tab of 

the spreadsheet – The column will show the duration of the sound records to improve usability 

of the session log tab of the spreadsheet. 

Issues Fixed 

5. 730, 721, and 821 Measurement Run Time displayed in the data spreadsheet was being 

displayed wrong – The time would increase the number of hours by one if the time had passed 

the half hour. This was introduced in G4 5.2.0 and has been fixed as of G4 5.3.0. 

6. G4 had spurious crashes when opening message dialogs – The crash was being reported as 

coming out of “cef.dll.” Crashes like these had occurred in the past for open and save file 

dialogs. In G4 5.3.0 the same fixes have been applied to all dialogs that G4 displays. 

7. 831C data files that contain corrupted audio records would cause G4 to hang when opening – 

G4 would get stuck in a loop trying to calculate the duration of the corrupted audio record 

because it expected a duration greater than 0 seconds. G4 now reports the 0 second duration 

correctly. 

8. G4 would crash when opening a large file that prompted the user to wait or ignore time 

history data due to how much there was when the user chose to ignore time history data – 

The crash was caused by the OBA time history graphs attempting to get data that may or may 

not have been processed based on how quickly the user had chosen to ignore the data. If the 

time history data is ignored the OBA time history graphs will not be displayed. 

9. HVM200 A(8) values were being miscalculated when applying exclusion bands – The original 

duration was being used in the recalculation. This would cause the A(8) values to increase when 

excluding a region with levels below the measurements overall averages when they should have 

decreased. 

10. 730, 721, and 821 files would show “%20” instead of spaces in notes added using the “Add 

General” button in the file list – This is an artifact of string encoding. This also caused G4 to fail 



G4 LD Utility Release History 

 

3425 Walden Avenue, Depew, NY 14043, USA  +1 716 926 8243 © Copyright 2014-2022 Page 5 
 

to show the file’s report. It was introduced in G4 5.2 to support multi-line notes and has been 

resolved in G4 5.3. It works fine for existing and new files. 

11. 831C Cloud File Push Authorization Issue – Auto-renewal of authorization would fail due to G4 

not providing the needed values to the meter at the time of the original authorization. This was 

introduced in G4 5.2 and has been resolved in G4 5.3. Manually reauthorize each meter with G4 

5.3 to correct the issue so the meter will auto-renew its authorization when needed in the 

future. 

12. Markers and Time History Notes not displaying their contents in the Time History Graph – The 

markers and notes icon would show but hovering over them would not show the contents in 

files that Room Acoustics (NC or RC) graphs visible. This has been resolved in G4 5.3. 

13. 730 No Motion Graph Line not always showing on Time History Linear Graph – The No Motion 

line would not be rendered every time the file was opened. This has been resolved in G4 5.3.  

 

G4 LD Utility Version 5.2.0 November 2024 

New 

1. Support for NC and RC Measurements – G4 supports using Room Acoustics NC and RC 

measurements on meters with the Room Acoustics option. This applies to 831C meters starting 

with firmware version 5.2 and 721 SE or 821 SE meters starting with firmware 1.400. The NC and 

RC graphs and metrics are configurable in the Custom Report for the 721 SE and 821 SE. 

Improved 

2. File Dialog Inconsistency – Several open and save file dialogs would use the previous dialogs 

path as the initial directory even though they were unrelated. Dialogs now use initial directories 

to start the user closer to where the related files would be located. 

3. UI Improvements in G4 – The file can now be viewed in Dark and Light mode. 

Issues Fixed 

4. 721 and 821 Measurement History Spreadsheet Tab had OBA Values Incorrectly Ordered – The 

OBA column headers showed all OBA Leq values, followed by all the OBA Lmax, followed by all 

the OBA Lmin. But the actual values were interleaved so the Leq, Lmax, and Lmin for each OBA 

bin would be in adjacent columns. This issue was introduced in G4 5.1.1, Spreadsheets exported 

with G4 5.1.1 or 5.1.2 with Measurement History and OBA turned on will need to be re-exported 

to correct this. A dialog has been added to G4 to resolve this issue by providing the user with a 

list of files that G4 is aware of that contains OBA and Measurement History and provide controls 

to review and re-export each file. 

5. Automatically Exported Xlsx Files Showed Warning – Corrected issue in spreadsheet formatting 

when automatically exporting during download. This did not affect data in the spreadsheet, and 

was corrected by the spreadsheet software that was opening it but it would still be reported. 

This has been resolved in G4 5.2.0. 
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6. 730, 721, and 821 Options and Firmware Upload Failure – Upload failures due to mass storage 

not being enumerated by Windows has been resolved in G4 5.2. Prior to G4 5.2 disconnecting 

and reconnecting the meter after receiving the error dialog stating “Unable to assign a drive 

letter for mass storage device" will allow the next option or firmware upload to succeed. 

7. Pause Button on Meter Manager Tab for 831C Did Not Work – The button in the G4 UI was 

sending an invalid command instead of a Pause command, it now pauses the 831C correctly. 

8. G4 Would Fully Connect Over BLE When a BLE Enabled Meter Became Visible – G4 no longer 

monopolizes visible BLE devices when it first detects them, which prevented other systems from 

detecting them reliably. This has been resolved in 5.2. 

9. 730 Merged Files Exchange Rate – When merging files, the exchange rate was being saved 

incorrectly. It is now being saved correctly in G4 5.2, merged files created with G4 5.1 up to G4 

5.1.2 contain exchange rates that will be interpreted as 3 dB higher than they should. G4 5.2.0 

will detect and correct these values when being opened. The only case that could not be 

detected to automatically correct are if all dose configurations in the merged file were custom, 

with the exchange rates set to 3 dB and a name was selected at merge time that matched the 

start date of the measurement. 

10. AudCal Custom Levels for Hearing Level and Narrow Band Noise Were Not Propagating – 

Custom levels had to be set with each test suite, now the previously used levels are propagated 

to the new test suite and can be modified from there if needed. 

11. AudCal Decimal Separator Correction in the RetSPL table - Resolved an issue where inputs into 

the RetSPL table containing a comma (',') as the decimal separator (e.g., 5,2 or 0,5) were not 

being parsed correctly, resulting in a 'Not a Number' (NaN) error. This fix ensures accurate 

numerical input handling across various international formats. 

12. Minor UI Layout Improvements – Fixed the sizing and positioning of a few UI elements in G4. 

Known Issues 

13. Failure to authenticate SFTP Cloud Storage on 831C – G4 may fail to include the encoded 

password before sending the configuration to the 831C. To resolve, enter credentials and click 

'Authorize' until successful, dismissing any error dialogs about SSH agent failures; once 

authenticated, data can be pushed until credentials require updating. 

G4 LD Utility Version 5.1.2 August 2024 

Fixed 

14. 831C Marine Mammals Protection Not in Report – Marine Mammals Protection metrics were 

not being displayed in the report when it had been enabled in G4. This is now corrected. 

15. 831A/831C Report PDF Not Generating – When viewing the report preview, clicking the “Save 

PDF” would not always display a Save File Dialog, and would not generate a PDF. Closing and 

reopening the report dialog and trying again may allow the report pdf to be generated. 

16. 721/821/831A/831C Time History OBA Graph In Report – Crosshairs were being rendered in 

the graph on the report for file with Time History OBA enabled. This caused the first time history 
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entry and bottom frequency appeared to have incorrect coloring. The crosshairs are no longer 

rendered to the report. 

17. 730/721/821 Custom Reports Configuration – When using G4 with a small horizontal size, the 

Edit Visible Elements panel would be partially hidden, now it will cover the right side of the 

report if needed. Widening the G4 view could resolve it if possible. 

18. 730/721/821 Settings Save Changes Dialog when nothing was changed – Opening the Custom 

Reports view in the settings page would cause a value to be refreshed in the settings view which 

triggered the save changes dialog when navigating away from the settings view. This no longer 

occurs. 

G4 LD Utility Version 5.1.1 July 2024 

Fixed 

19. A sporadic crash when using the open file dialogs in G4 has be resolved  – Sometimes when 

selecting a file of any kind in G4, the open file dialog would fail to load correctly and would 

hang/crash G4. Often if this hang/crash did not occur then if the dialog was left open for about a 

minute then G4 would silently close. 

G4 LD Utility Version 5.1.0 June 2024 

New 

20. 730, 721, and 821 Added ability to customize the report – See the G4 Welcome help topics to 

learn more. 

Improved 

21. 730, 721, and 821 settings files will allow the user to use defaults if newer settings are absent 

– Settings files created with older version of G4 will not contain new settings, as of G4 5.1 when 

importing settings files for these meter that are missing newer settings the user can choose to 

either use the default values or use the current values for missing settings. 

22. 831C Agency Approval status in the file is now displayed in the report – The agency approval 

block is now in the report if the file was created on a meter with the Agency Approval option. 

Fixed 

23. Pushing a 730 settings file with OBA and/or Event Sound Recording settings to a meter that 

doesn’t have those options installed now works correctly  – When a settings file created on a 

730 meter that had the OBA and/or Event Sound Recording options was pushed to a meter that 

didn’t have these options, issues were reported in the measurement settings and no system 

settings were pushed. Now, invalid settings for these two options are no longer pushed. In 

addition, system settings will be pushed, regardless if there are issues while pushing the 

measurement settings. 

24. On the 831C report, the Community Noise LDN LNight value now shows the correct value – 

Previously the value for this metric always showed “0.0 dB”. 

25. 730 File Bump Exclusion Bands – The Bump Exclusion bands were not being generated for files 

with more than 40000 time history records and were not being saved for files of any size. 
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Smaller files would prompt to save the bands instead of automatically saving them. They will 

now be generated and saved. 

26. 721, and 821 Notes were not being cleared when resetting the measurement – If the meter 

was already reset and then notes were added pending an upcoming measurement, resetting the 

measurement without first running from within G4 would not clear the notes. Resetting the 

measurement from the meter’s UI worked correctly, and now resetting the measurement from 

G4 also works correctly. 

27. Audio Records could not be played if between time history interval boundaries –  Playing 

audio records from the graph only worked if a valid time history interval time was included in 

the sound record.  The sound record was playable from the session log sheet, but not the graph. 

Now sound records can be played from the graph even when they do not cross an interval 

boundary. 

28. Markers and notes can be deleted/edited and changes will persist – Now a note can be edited 

and markers can be removed and the changes will be saved and loaded correctly. 

29. Adding notes or markers containing the ‘#’ symbol would truncate at the ‘#’ symbol – Now 

notes and markers can be added with this character correctly. 

30. Translation and parsing error are now reported in an “Issues” row – They used to be saved 

with the notes and could be edited, now the issues separate and not editable. The Issues row is 

only visible when issues were detected during translation of the file. 

31. HVM200 edit bands with Whole Body would not apply Sum Factors – This only applied to 

adding or removing edit bands. Re-opening the file after removing the edit bands would show 

the correct values. Now the values are calculated correctly. This will automatically be applied to 

files that have already been downloaded and have edit bands the next time they are opened in 

G4 5.1 or later. 

32. 730, 721, and 821 spreadsheet and report updates – Dosimetry section of spreadsheet and 

report did not show the correct value for exposure limit. LAIeq values were missing from the 

spreadsheet and reports. Modified summary spreadsheet page had different formatting than 

the un-modified summary page. 

33. 721 and 821 specific spreadsheet and report updates – Custom microphone Under Range Peak, 

Under Range Limit, and Noise Floor values were showing invalid values. 

34. Saving changes to default setups for 831C saves modifications – Previously the modifications 

would not be saved to the new setup file that was created when being forced to “Save As”. As of 

version G4 5.1 the changes are now saved correctly. 

35. 831C missing Statistics tab in spreadsheet – The Statistics tab was missing from the spreadsheet 

for files made by 831C FW versions 4.9.5 and later. This issue was introduced G4 version 5.0. 

36. 831C Overall Ln showing 0.1 dB low – The Overall Ln levels were 0.1 dB lower in the 

spreadsheet than what was actually being measured on the meter. Now the levels displayed in 

the spreadsheet match the levels shown on the meter for the measurement. 



G4 LD Utility Release History 

 

3425 Walden Avenue, Depew, NY 14043, USA  +1 716 926 8243 © Copyright 2014-2022 Page 9 
 

G4 LD Utility Version 5.0.0 April 2024 

New 

1. Added 377A12 ¼” Microphone – supported in all 721 and 821 meters as of firmware 1.200. 

2. Added LD7 folders parse functionality – Can now translate 821,721, 730, and 730IS .LD7 folders 

into .LD7 files using the File->Import Files->Import LD7 menu option.  

Improved 

3. Linear and OBA Time History Graphs for 721, 821, and 831 files – Interactions between the 

Linear and OBA graphs have been improved. The legend values now update for all graphs and 

OBA spectrographs all highlight the same frequency as applicable. A frequency can be selected 

by clicking on either the spectrograph or the overall OBA bar chart to lock it in so movement on 

the X-Axis (time) will show values for the selected frequency at that time. 

4. Linear Graph now shows the interval’s level for each metric as a stepped line – As sub-interval 

values are not available and cannot be implied the level is shown as the same for the entire 

interval instead of interpolating between two points with a slope. This also aligns each step with 

the OBA Spectrographs. 

Fixed 

5. HVM200 Format and Restore command is now sent correctly – This will reset the setups, 

sensor list, Wi-Fi configuration, CalCheck histories, and remove all data files. Previously, both 

Format and Format Restore would send only a Format command. See the HVM200 Release 

Notes for more details. 

6. HVM200 Data File’s modified overall data section MTVV or Amax values – The time history 

values used to recalculate the MTVV or Amax were incorrect in the file prior to HVM200 version 

5.0.0, G4 now shows a note in place of incorrect values when using edit bands for files made 

with older firmware and shows the correct values for files made after being upgraded to version 

5.0.0. 

7. Agency Approval summary for SoundAdvisor 831C – All files with a broken agency approval seal 

would always report non-approved firmware version as cause even with approved firmware 

versions. 

8. Data File List from SoundAdvisor 831C would not refresh automatically – This affected 831C 

meters with version 4.1 through 4.6.2. The issue was introduced in G4 version 4.7 and is 

resolved in version 5.0.0. 

9. AudCal RETSPLs were not always being applied – The meter would sometimes miss the 

notification to load new RETSPLs when the user would move to the next transducer type, side, 

or test during a test run. 

10. HVM200 OBA displayed units correction – OBA data for the HVM200 are not integrated but the 

displayed units applied integration incorrectly. (e.g. input units set to ‘m/s2’ with double 

integration will show units of ‘m’ on the linear data and now show ‘m/s2’ on OBA data instead of 

the errant ‘m’ on OBA data) 
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11. Push to Cloud Authorization Expiration – When authorizing a meter to push to Dropbox, the 

meter was not being properly configured by G4 between 4.9.2 and 4.9.6, this prevented the 

meter from pushing for more than four hours after each authorization requiring the user to 

reauthorize repeatedly. To correct the configuration issue on the meter repeat the steps to 

authorize the meter using G4 version 5.0.0 or later. 

12. Graph Selection Summary – With the feature to highlight a section of a time history graph to 

view a summary (star icon), when selecting an area that includes a period with no data (paused 

or stopped), the results reported were incorrect.  Selecting areas with no data now shows 

correct results. 

Deprecated 

13. Discontinuing 32-bit versions of G4 – 32-bit builds of G4 will no longer be made available. 

14. Discontinuing Windows 7 Support for G4 – Running G4 on Windows 7 is no longer supported. 

G4 LD Utility Version 4.9.6 January 2024 

Fixed/Improved 

1. When uploading default settings from G4 into a legacy LxT meter, the incorrect nominal 

microphone sensitivity was set – The nominal sensitivity is only used to validate that a 

calibration level is in the expected range, so this would cause the meter calibration to display a 

warning that it was out of normal range. This does not affect measurement data. The correct 

nominal values will now be set when uploading a system properties file from G4 using the latest 

version. The “Restore Defaults” functionality on the meter was not affected by this issue and 

continues to work correctly. 

2. G4 would display Spectral Ln data incorrectly from 831C meters with firmware version 4.9.5 – 

Files will display correctly if opened in G4 version 4.9.6. 

3. G4 would sometimes not detect 730, 721, and 821 devices over BLE due to incorrect 

initialization – The detection and communication for BLE is correctly being initialized in G4 4.9.6. 

4. BLE communication was unstable for some devices – When G4 would detect 721/821 devices it 

would begin requesting data prematurely from all 721/821 devices. This could lead to BLE 

communication stopping. G4 version 4.9.6 uses correct timing and conditions to communicate 

with the device. 

5. Background services would not auto download data files from 730, 721, and 821 devices – The 

services failed to respond to file list changes. In G4 4.9.6 the services will now respond by 

getting the file list and downloading new files. 

G4 LD Utility Version 4.9.5 December 2023 

Fixed/Improved 

1. G4 would fail to update 831C firmware from versions older than 4.0.0 – Introduced in G4 4.9.0, 

if an 831C had firmware older than 4.0.0 G4 would fail to update it. 

2. G4 would prematurely round Measurement History data for 730, 721, and 821 – The value was 

rounded to 1 or 2 decimal places which could introduce error if used for other calculations. 
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3. G4 fails to get a file list or download from meters with a space at the beginning or end of their 

nickname or containing project name in the G4 Device Panel – This prevents listing and 

downloading files from these meters including automatic downloading of files. This is the local 

name a user can assign to their connection to the meter within the G4 Device Panel and not the 

meter’s Device Name. G4 now removes these spaces from existing meters and projects when 

installing the new update and removes them when setting the new meter nickname or project 

name. 

4. Issue viewing files with the same tab label as other files – Previously, if multiple files were 

opened that had the same text in the tab label, only the left most tab could be selected to view. 

Additionally, attempting to close one such file would close an additional file with the same tab 

header as well. The tab header is dependent on the type of file being opened but 730, 721, and 

821 share a file type and 831C and Legacy SLMs share a file type. The file name is When closing 

any files that had the same label as another open file, G4 would close two matching files at a 

time. The work around was to only have one file from each start time open at once. 

5. Issue opening multiple files at once – Opening several files at once regardless of file type, either 

by selecting multiple files in the Open File Dialog from the “Open Data File” menu item or by 

checking multiple files that are already downloaded in the meter file list and clicking the “Open” 

button above the file list, had a low probability that some files fail to open. e.g., when opening 

15 files at once, less than 15 file tabs appear. They will now all open. To avoid this in previous 

versions only initiate one file open at a time. 

6. G4 allowed invalid characters in the Marker settings fields for 721, and 821 – Some characters 

would be removed from the settings when saving, others were not removed and would result in 

files that G4 could not parse. When a character was removed it would show a warning that the 

setting had been changed when it was saved. Now a tooltip is displayed when hovering over the 

Markers input fields explaining the input restrictions (i.e. "Use up to 16 characters from the 

following set: lowercase letters (a-z), uppercase letters (A-Z), numbers (0-9), and the # 

symbol."). The invalid characters and any character after the length limit are ignored during 

input. In previous version of G4 the same restrictions were present but only partially enforced 

during saving not during input entry. When using older versions please adhere to these 

restrictions. 

7. G4 would fail to set the clock on 730, 721, 821 if Auto-Store was disabled – This would occur if 

the meter had collected the data for a measurement but had not stored the measurement to a 

file. G4 now presents a warning dialog indicating the issue and providing appropriate actions. 

Having Auto-Store enabled or ensuring that the file was stored before attempting to set the 

clock would prevent this issue. 

8. AudCal Broadband Noise Test not starting in G4 - Three frequencies were tested for flatness 

and magnitude as part of verifying the test pre-condition but no message was shown explaining 

when the conditions were not met. Now a message will be displayed informing the user that the 

conditions are not met (i.e. "Not detecting an input signal with 1000 Hz above 50 dB HL") either 

before the test starts or if the signal drops below the specified level during the test.  
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9. AudCal Broadband Noise Test not preserving test result in G4 – Switching to another test and 

then back to Broadband Noise would lose the test data from the previous Broadband Noise test 

run. This is now fixed to allow viewing other results without losing the data from the Broadband 

Noise test.  

10. Improved error message when file download fails – G4 will display a message box when an 

error occurs involving an ongoing file download from a meter. Previously the download would 

error out without warning. 

11. Corrected displayed values and units in FFT files using non-microphone transducers (e.g. 

Accelerometer) – The y-axis units selection drop down in the graph view showed base units 

without integration applied. Now it shows them correctly. The Harmonic Distortion section 

showed values in the transducer’s units but labeled them with the Display Units, they are now 

converted to the display units and labeled correctly. G4 showed the RMS value with units 

matching integration when the value is not integrated, the value is no longer displayed when 

integration is enabled. 

12. Displayed Metric was mislabeled in the file list – The metric displayed in a meter’s file list for 

downloaded files would show the value for Leq but label it incorrectly if it had been set to Lpeak 

prior to the labels being standardized to Lpk. Now, any metric that had previously been set to 

Lpeak will be changed Lpk. This could be corrected manually by going to “Tools->Options- 

>Displayed Metrics” and correcting any blank drop-down selectors. 

G4 LD Utility Version 4.9.4 November 2023 

Fixed 

1. Fixed issue that prevented installation on 32-bit systems that was introduced in 4.9.2. 

G4 LD Utility Version 4.9.3 November 2023 

Fixed 

1. Fixed issue that prevented 831C, HVM200, and Legacy SLM drivers from installing on newer 

versions of Windows 10 and Windows 11. The driver will now install on Windows 10 and 

Windows 11 system. 

G4 LD Utility Version 4.9.2 October 2023 

Fixed 

1. Fixed issue introduced in 4.9.0 that prevented 831C, HVM200, and legacy SLM drivers from 

installing. 

2. When opening an LD7 file from a 721/821, the spreadsheet for 721/821 files always showed the 

slow detector spectra for the Overall OBA but labeled it with the detector specified by the 

meter’s settings. The correct spectra will now be displayed and labeled correctly for any data file 

opened with G4 4.9.2 and later. 

3. LD7 files generated by the 730 and 730IS with firmware older than 1.118 had the TWA3 and 

TWA5 values swapped in the time history data. G4 now accounts for this when opening files 

created by 730 FW older than 1.118 and displays them in the correct columns. It will also correct 
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any modified data including Dose, Projected Dose, Lavg, TWA(8), and Projected TWA(8) data 

that were calculated using the incorrect columns. To correct any results that were previously 

exported to other file types, they will need to be re-exported. 

4. A bug that prevented opening a Bluetooth connection to a 730, 721 or 821 after it was 

calibrated has been fixed.  This bug would cause the meter to appear inactive (grey text) in the 

device list. G4 would erroneously connect and communicate over BLE to 730/721/821 meters 

that were visible in the meter panel when they finished a Calibration. This prevented the meter 

from advertising to other computers or devices and could make the meter appear unavailable 

from the device list. 

5. Marine Mammals Protection files created without Event History can now be accessed in G4. An 

upgrade to version 4.9.2 resolves the issue that prevented these files from opening in version 

4.9.0. 

6. When exporting settings files the default path was incorrect and caused the export to fail.  The 

default path now works. 

G4 LD Utility Version 4.9.1 June 2023 
1. Updated firmware for Spartan 730, Spartan 821/721, and SoundExpert 821/721 meters. 

G4 LD Utility Version 4.9.0 June 2023 

Added 

1. G4 supports the new Spartan 821/721 and SoundExpert 821/721 meters.  

Improved 

2. The linear graphs in the file view will display data that exceeds the extremes of the y-axis. Single 

points will be marked to help visualize the data. 

3. For the Spartan 730, notes entered in files show in the Notes field in the report and in the 

summary data tab, while notes entered during a measurement will be captured as markers. 

4. Renamed “Comments” column in Measurement History, Event History and Time History tabs to 

“Markers”. 

5. OBA spectrogram left align with the associated linear data points and take into account the size 

of partial data records when the time history period is greater than one second. 

6. Updated G4 to include latest security updates for browsing meters. 

7. Labels for peak are now pk. 

8. Improved settings conflicts for RT60 measurements. 

9. Added Reset state in the meter panel for 831C. 

10. Eliminated need for administrator privileges to disable and enable the automated download and 

connection services from G4 Options. 

11. File search now includes models (e.g. 831C, LxT, 730, etc.)  and serial numbers. 

12. The graphs show values that extend beyond the extremes of the y-axis. The single data points 

on the graph also do not completely disappear if not connected to other points in the visible 

portion. 
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13. Forces y-axis max and min values to be different on graphs and auto-corrects if identical values 

are entered. 

14. You may move the Edit Band popup, enabling you to see and inspect the graph while configuring 

the edit band. 

15. AudCal: The New Zealand standard prints on the associated booth test. 

16. Enabled ability to change the time fields on 831A without having to enable Host Port or GPS. 

Fixed 

17. General Info would not persist in the spreadsheet when navigating to the report. 

18. Cancelling the Marine Mammal popup would inhibit future processing using this feature. 

19. Data spreadsheet did not allow navigation using arrow keys. For example, pressing the down 

arrow to navigate to the next cell in a column or Ctrl-⇩ to jump to next non-empty cell in the 

column. 

20. AudCal: Generating booth test certificates, only the first one would work, where subsequent 

tries would fail. 

21. AudCal: Extra Audiometers would show up in the generated “Audiometers Due for Calibration” 

report. The report would not generate unless you enabled the automatic notification option. 

22. AudCal: Linearity would not store test data performed for frequencies other than 1 kHz. Now, 

the report will show the last tested frequency. 

23. AudCal: The speech RETSPL was set at supra aural level regardless of the specified transducer. It 

now follows the correct level for the chosen transducer. 

24. AudCal: The Hearing Level test displayed results on the report with an extra column that G4 did 

not labelled, shifting the data to the right and truncating the last column. 

25. Markers added to Measurement History and Event History tabs now get stored when saving the 

data spreadsheet. 

G4 LD Utility Version 4.8.3 March 2023 

Fixed 

1. Fixed issue where G4 would not download updated firmware packages when they became 

available on the web. 

2. Fixed issue where G4 would not display the correct LCeq value when the meter triggers a 

calibration on the 730. 

G4 LD Utility Version 4.8.2 February 2023 

Fixed 

1. 831C AudCal: Reports work correctly when language is set to French. Added New Zealand 

standard to Booth report. 

2. Fixed issue that would cause USB communication with 831C, 831, or LxT to not work when G4 is 

installed for the first time. 

3. When “Allow Auto-Download from available configured meters even when G4 is not running” is 

checked, files would only download when G4 was open and not when it was closed. 
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4. Auto Download service would crash when firmware on 730 meters were being updated. 

5. Criteria for accepting calibration results on the 730 has been tightened to improve overall 

calibration accuracy. Requires 730 FW version 1.114 or later. 

G4 LD Utility Version 4.8.1 December 2022 

Added 

1. We updated Audiometer Calibration to use the ANSI S3.6 (2018) and ANSI S3.6 (1989) 

standards. This requires a change to the settings for tests with speaker transducers when using 

2010-2017 standards, in which the Binaural selection provides a Diffuse setting. The tests using 

standards 2010-2017 show Left/Right sides (Diffuse) for previously executed tests and only the 

Binaural selection for tests from now on with the checkbox for diffuse. Tests using the standards 

from 1989 to 2004 continue to show the Left/Right sides (Monaural) for speaker transducers. 

For the 2018 standard, the tests for speaker transducers display only Binaural with additional 

angles (from the standard) and the diffuse checkbox.  

 
2. AudCal support for booth testing in compliance with New Zealand document, "Assessment of 

occupational noise-induced hearing loss for ACC", page 25.  

We added an entry for standard "NZ ONIHL-ACC" to the standards drop-down box. This 

selection will show MPANL options for "Air", "Bone" and "Custom" (defaults to the same limits 

as "Bone"). G4 will show only the seven frequencies defined by this standard for these test runs. 

3. You may now setup a time sync between your PC and your meters. In the Tools > Options, you 

can choose to enable the Time Sync to the meter at a given time of day. If using services, they 

will perform the sync in the 

background. Otherwise, you 

will need to keep G4 running to 

perform the auto time sync. On 

a Model 831, ensure that the 

Time Zone Offset is correctly 

setup in Preferences.  

 

This new time sync option enable three different options for sync’ing time- 
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a. Option 1 = NTP (most accurate): Only available on the 831C and requires GPS and/or 

internet connection. If NTP is set on the meter, then G4 will not time sync. This is the 

recommended method for the 831C.  

b. Option 2 = Sync on Open: Available for all meters and happens at time of opening the 

meter. G4 will ask to sync time and user can select yes/no except for Spartans where 

time sync's occur automatically when time is greater than 4 seconds.  

c. New in G4 V4.8, Option 3 = Sync on schedule: the Time Sync works for all meters except 

where the 831C using NTP automatically disables it. We designed this option for 831 

meters continuously connected by 831-INT-ET. If G4 does not connect to the meter at 

the time of the scheduled sync, then the service will sync time on the next scheduled 

sync. Typical accuracy is +/- 2 seconds. 

4. After changing the meter's name in the Meter Panel, you can instruct G4 Services to push the 

name to the meter's chosen System Property device field. If you do not have services 

configured, then the update occurs only while G4 is open. 

5. G4 automatically updates documentation and firmware packages, configurable from the Tools > 

Options. 

 

 

Improved 

6. Downloads are more robust with communication validation improved. Each meter allows one 

download at a time. 

7. 831, 831C, 730: G4 sound record processing has been improved to generate consistent sound 

record file names when exported via command-line processing, automatic downloads, or saving 

from the Audio Player. The sound records are placed in a sub-folder next to the input .ldbin file. 

The sub-folder has the same name as the input file with "_SR" appended to the end.  

 

Inside the sub-folder, each sound record is named as follows: 

831, 831C 
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Following is an example of sound record file naming: 

 

730 

 

Following is an example of sound record file naming: 

 

Fixed 

8. Fixed issue where one meter type would show incorrectly (e.g., 730 looked like 831C). Updated 

communication ports in Tools > Options to display an accurate port. 

9. 730: Correctly reads the "Custom" settings when switching to Custom in the virtual dosimeter 

settings. 

10. Issue where the Live View would not display correctly for all meters when the G4 language is set 

to PC and the PC region/language is not one of the supported languages. 

11. Auto downloads might stop before completion when the meter has more than 50 files to 

download.  

12. With continuous sound recording, audio playback on graphs sometimes skips to the last sound 

record after playing any other record. When playing compressed audio files, you can now start 

playback at any point. 

13. Updated graph data to use proper English units. 

14. When opening an SLM file with Time History and OBA data only, G4 might not load the graph. 

15. After installing G4, meters would not connect over USB.  

16. When both measurement and event sound recording is enabled, the event sound record 

numbers and associated playback on the Event History data tab did not match the correct sound 

recording from the Session Log. Exported records still match the correct event. Opening ldbin 

files will be corrected with this version of G4. Previously exported JSON and spreadsheet files 

(.xlsx) will need to be re-exported to fix the numbering. 

17. After creating an edit band that modified a 730 file, several fields displayed a time stamp when 

none should exist in the modified data on the Overall tab.  
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Known Issues 

18. When the meter has over 1000 files, the 831C's performance is adversely affected and can cause 

an unexpected meter reboot. To prevent this, keep the number of files less than 1000. You can 

do this using the automatic delete feature in the 831C. 

19. Model 831A, if sound records for both measurements and events are on, the measurement 

sound recording will override the event sound recording if they overlap. You may decide to 

disable the measurement sound recording to keep all the event sound records. 

20. In G4 when a download starts, if another user or service was in the process of downloading, the 

meter will stop the first download, allowing for the new request to begin. 

G4 LD Utility Version 4.7.1 May 2022 

Fixed 

1. 831C: Certain strings in Italian caused the UI to lock up in G4 Live View, Setup Manager and 

certain graphs. 

G4 LD Utility Version 4.7.0 April 2022 

Added 

1. RT60 measurements are supported on the 831C. RT60 measurements taken with the 831 or 

831C can be viewed graphically with Position Ensembles and the ability to exclude and include 

individual decays. Note: to view graphs or the new features with the data from an 831, Save All 

Time Series must be selected in your setup before taking data. 

2. Measurement Description for the LxT, 831 and 831C meters included in the search index. When 

you download or open a file it is indexed. Old files that were downloaded prior to installing G4 

version 4.7.0 will not be indexed except when navigating to Tools > Options > Displayed Metric 

and clicking on Force Refresh of Old Files. 

3. A preset dosimeter configuration called Canada has been added to support the new worker 

exposure PEL of 85 dB Leq. 

4. In the file Time History graph, you can select the star to enable selection of a period of time and 

see summary information such as Leq for the selected time. A checkbox in the resulting popup 

allows users to choose between viewing summary results for visible data or all available data. 

5. 831C: The meter live view displays the file name of the active settings and marks the name with 

an asterisk after active settings are modified. 

Improved 

6. Updated the live FFT full screen graph to use more of the available space in the view. 

7. 831C AudCal: Allow modification of the default test frequencies for audiometers. Modified 

defaults are stored and used for all subsequently created audiometers. 

8. Spartan 730 & 730IS: Shift Time setting added to all dosimeter configurations, including OSHA-

HC and OSHA-PEL and also added to reports. 
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9. 831C: Format and Restore is only allowed when connected by USB. This is to protect remote 

installations from losing connectivity due to a remotely initiated Format/Restore defaults. 

(12008, TT7369) 

10. 831C: Allow meters to have the same hostname/IP address as long as they are configured to use 

different ports. (12587) 

11. 831C: In the G4 Live View, when viewing the Live data from an 831C, the meter displays the 

most recent one second Leq and Lpeak levels. Data labels have been updated to show the 1 second 

time period. 

12. 831C: When connected to a meter using a network connection, users are required to have 

Administrator rights in order to Format. You must be connected via USB to perform a Format 

and Restore. 

13. 730: The auto calibration has been improved so the meter will reliably enter calibration when a 

calibrator is connected and the meter is stopped. 

Fixed 

14. 730: Updated the OSHA-HC Criterion Level (set to 90 dB from 85 dB) and Action Limit in Alarms 

(set to 50% from 75%) to match the standards. G4 will automatically update and correct any 

measurement file that used the previous settings when that file is opened. 

15. 730: Data files with more than one million time history records now opens. Previously the initial 

one million records were on the first time history sheet and subsequent data sheets duplicated 

the first. Note: The graph will only show the first million records. 

16. 831C: The Event Triggers for SPL1 and PK1 levels no longer get set to 0 dB when transferring a 

default file from PC to the meter and set to active. (12198) 

17. 831C: The command line export of a data file to XML or JSON failing when the file contained a 

sound record is fixed. (12412) 

18. When searching in the File View with zero results, the list will no longer jump to the end of the 

list. 

19. HVM200: When upgrading firmware over WiFi the upgrade would fail without warning. Meters 

with firmware prior to this version should use a USB connection to upgrade. Upgrades after this 

version will succeed. 

20. 831C: Email will no longer queue if hostname is blank. 

21. 730: The Virtual Dosimeter 1 could be turned off resulting in the data not being visible with no 

way to re-enable virtual dosimeter 1. By design virtual dosimeter should always be enabled and 

G4 now ensures this.. 

22. 730: If more than one timer was enabled, daily timer merge was on, and you ran and stopped 

manually prior to the first timer block, then the time history for that run would not store in the 

file. 

23. Command line naming options set in Tools > Options > Command Line Setting were not being 

used correctly when using the command line to process files giving different names than 

expected. 
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24. When creating a report or certificate the name of the file was not displayed in the subsequent 

popup. 

25. On the 831C UI, the Time History "OBA by Time" page did not display the data. (12050) 

26. 831C: AudCal no longer enforces a limit at 8 kHz for bone vibrator Hearing Level test. Note that 

the standard has no specified RETFL for this frequency. (12018) 

27. 831C, 831 & LxT: In a file time history graph and you have changed the y-axis extremes, the y-

axis extremes would reset after zooming in the x-axis and resetting the zoom. 

28. 831C Settings: The range in dB presented with selecting the Normal or High range for OBA and 

sound recordings could be incorrect when +20dB Gain is checked and unchecked. 

29. Folder selection (including Import from USB or Save All Audio Files) would crash G4 if Federal 

Information Processing Standard (FIPS) is enabled on the computer. (12554) 

30. 831C: Dropbox authorization updated to work with File Push feature. 

31. 831C: In FFT mode, the full screen graph would not update with harmonics enabled. 

32. 831C: Audio Streaming from an 831C would not work sometimes. 

33. 831C: Dropbox discontinued long term authentication tokens. With this release we have 

implemented a new method of security authentication that allows the meter to continue to 

push. 

34. AudCal database sync with meter would produce an incompatible version message and would 

not sync. 

Known Issues 

35. When downgrading the 831C, the meter may lose settings if the settings are new to the 

firmware.  

36. If you have data on the meter not stored when you upgrade firmware the meter may not 

recover the data after the upgrade. Be sure to store data before you upgrade. 

G4 LD Utility Version 4.6.6 January 2022 

Added 

1. Added support for the AMC493C mastoid. 

Improved 

2. A pencil icon now denotes the comments in the graph, and no longer moves off the graph when 

adjusting the y-axis extremes. 

Fixed 

3. During installation some files were installed with permissions that don't allow access from users 

without Administrator rights. This results in G4 not being able to connect to meters or list files. 

4. The connections to Spartan 730 meters over BLE would drop because G4 tried to open too many 

connections simultaneously. 

5. The Spartan upgrade process could have failed if the meter had old BLE firmware. G4 now also 

provides more details in response to upgrade process. (TT7219) 

6. In the HVM200 File View, you can see and download .raw files. 
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7. The 831C Firmware upgrade process has improved communication that is now more error 

tolerant. 

8. AudCal: Fixed issue with the environmental adjustments for the AMC493 mastoid where the 

adjustments were being subtracted instead of added. 

9. When using commas for the decimal separator, the Spartan 730 file in G4 would display the 

LAeq, LCeq and LZeq incorrectly by a factor of 10. 

10. Adding projects directly to the "Projects" group will no longer insert them into a random project. 

Some old projects had invalid settings that caused the problem and these now have proper 

settings. You can find the misplaced projects previously inside these corrected projects directly 

under the main "Projects" collection. You may decide to move them back inside a parent if 

desired after updating G4. 

11. SPL 1 and Peak 1 did not update the Event Trigger Levels when making changes on the 

Exceedance Triggers page. The fix also affected the transfer from PC to the meter in Setup 

Manager. The SPL 1 and Peak 1 values no longer transfer as zero. 

12. If the user selected cancel during a firmware upgrade, the Spartan 730 would go offline for 

several seconds. 

13. G4 correctly handles mapped network drives that uses drive letters. 

14. G4 would not start a second instance if services were turned on but not running. 

15. When opening an SLM file, G4 would display a graph for an instant and then disappear, or would 

show extra lines returning to the first of the graph. 

G4 LD Utility Version 4.6.5 November 2021 

Features 

1. The Time History graph for SLM files now includes non-acoustic metrics such as weather or 

voltage. Time stamp at cursor location added to the values legend. 

2. Spartan and SLM files: Comments can be added to the Graph and SLM data views for 

Measurement History, Event History, and Time History. Comments entered into either the 

Graph or the Time History Data View will show up in both places. 

3. You can specify from a list of metrics (Tools>Options>Displayed Metric) which one you wish to 

display in the File View column titled Metric. 

4. Added computation of metrics for marine mammal protection, which can be enabled in Tools > 

Options > Misc. 

5. Added the Audio Calibration Constant to the 831C's Data Summary tab, which can be used to 

convert the meter's recorded audio files. 

6. Addition of the LAIeq Live and Overall values to the Live View for Spartan 730 and 730IS meters. 

7. By default, using G4 to delete files from the PC now moves those files to the recycle bin rather 

than permanently deleting them. You may override this in Tools > Options > File or on a case by 

case basis. 

8. Calibration and Audio Streaming tabs have moved to the top navigation from the meter 

Manager tab. You can Audio Stream from the same meter to multiple instances of G4 on 

different PCs. 
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9. Part of G4 has been moved from the G4 application to software that always runs in the 

background on a PC. In Windows terminology this is called a Service. These new services called 

LDConnectionService and LDAutomationService monitor available connections and auto 

download files in the background even when G4 is not running. This allows files to automatically 

download from available meters without requiring a user to be logged in. These services also 

speed up launching of G4. If this functionality is not wanted, the services can be disabled by an 

administrator and G4 will only monitor connections and auto-download when it is running. 

10. HVM200: Added microns (µ) as selectable units. µ/s² can have the integration applied to 

become velocity or displacement. Added Crest Factor to the Summary page. 

Improved 

11. To speed up the process of opening files from the File tab, G4 no longer exports the data to .xlsx, 

.json, or .csv files. Export occurs when a files is downloaded or opened and imported from an 

SLM Archives. This Change prevents G4 from creating the same export multiple times and 

potentially overwriting changes in an exported file. The command line interface can be also be 

used to create export files. 

12. SLM and HVM200: The Files view has been improved to reduce the refresh time when you have 

several files downloaded. 

13. The file list for 831C and Spartan instruments now displays measurement units in the metric 

column. 

14. Command Line file processing handles trailing backslashes in file paths.  

15. Updated the axis for FFT graphs to display the numerical and logarithmic values. 

16. The Setup File Import has improved messaging and buttons to help make decisions easier 

(10743). 

17. Setup Manager now refreshes the list of setups after doing an Import Settings or Extract From 

File (10806). 

18. Logos and signatures are saved with higher resolution to improve the quality of reports. It may 

be necessary to re-import logos and or signature files to get the improved resolution. 

19. AudCal: Updated the signature pad to provide better feedback and the buttons to help choose 

the signature to use. 

20. When displaying a graph on a report, the graph legend only shows items that are active on the 

graph at the time the report was created. 

21. SLM files: Added Instrument Identification fields to spreadsheet on the Summary tab, in the 

Overall Settings section. This information is setup in the meter System Properties. 

22. The G4 Options dialog accessed using Tools > Options now stacks tabs rather than scrolling to 

allow better visibility of all tabs. 

23. HVM200: When changing the operating mode (hand-arm, whole body, vibration); the x, y, and z 

weightings and the k-factors update to match the defaults for the selected operating mode. 
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Fixed 

24. Spartan: Multi-line notes on the Summary page now show more that the first line of the note 

(11450). 

25. Spartan: When General Info is modified either in the data view or the report view, the 

information is now shared in both places. 

26. Spartan: The sensitivity will not get sent to meters when using the Push Settings feature. 

27. Wind Speed was always reported using English units on Time History worksheet when the meter 

was configured for Weather-INT. G4 now reports the units configured in the Weather-INT 

settings. 

28. Spartan UI: The battery percentage is now correctly reported in the Live View tab - Meter 

Overview. 

29. A bug causing G4 to not show valid sound records for some data files has been fixed. 

30. When there are more than 5000 time history records in an Event History the records greater 

than 5000 now have a record number (11346). 

31. Using G4 to load a settings file to the SoundAdvisor 831C that contains invalid settings could 

result in the meter no longer being able to store calibrator settings. G4 now validates settings 

before transmitting them to the SoundAdvisor 831C (11512). 

32. In AudCal mode the Calibration Tab would switch to match the Live View when a test is run. 

33. Fixed the arrow above the OBA and SLM overload indicators where it would display one or the 

other but not both. 

34. The Add Logo button now works for Spartan reports. 

35. AudCal: Corrected "Set OSHA Levels" in Hearing Level. Changed level to 70 per OSHA standard 

(11447). 

36. AudCal: Fixed issue with the environmental adjustments for the AMC493 mastoid where the 

adjustments were being added instead of subtracted. 

37. Updated the Full FFT Live graph to correctly handle CPM with harmonics and Show Max. 

38. 831C-FFT: When setting custom units with other transducer, the meter would show wrong 

display units on the calibration settings page. 

39. FFT Chart: Fixed FFT chart so that Y-axis scales properly when switching between Linear/Log, 

selecting units, and selecting items to display from tree. (11663) 

40. HVM200: When entering notes in General Info the additional notes are now appended to notes 

already in the file rather than overwriting existing notes.  

41. HVM200: When an HVM200 file is deleted from the local PC the associated .meta file is also now 

deleted. (11856)  

42. HVM200: When using G4 to delete HVM200 files, sometimes the cursor would change from the 

spinner prior to the delete operation actually completing and the file list updating. The spinner 

cursor now always remains active until the file delete operation and display update has 

completed. 

43. Command-Line Process: When processing multiple files, a defect resulting in some files failing to 

export is fixed.  
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44. 831C: When the meter is configured for a weather sensor and there is no weather sensor 

connected or a connected weather sensor is not sending data, invalid data "---" or -99.9 is now 

reported for Wind and Gust Speed. Previously, negative values could be reported. 

45. The file name and user info entry fields are merged on the Summary worksheet to use 6 

columns so that the reports do not shift to multiple pages. 

46. When clicking a sound recording from within the Session Log the sound recording now correctly 

plays. Previously the sound recording wouldn't play until after clicking away from Session Log 

entry. 

47. 831A, LxT: The file data view for the Calibration Deviation in the summary and the Calibration 

Changed entry in the session log would show incorrectly. 

Known Issues 

48. If G4 is running with active meter connections (meters showing on the tab display) when 

Windows is locked, the meters on the tab display will become unresponsive.  

a. Workaround – close and reopen the tab 

G4 LD Utility Version 4.6.3 September 2021 
1. Fixed issue with HVM200 files not opening. 

2. Updated SoundAdvisor Model 831C firmware. 

G4 LD Utility Version 4.6.2 May 2021 
1. Support for LNE, French national, pattern approval. 

2. Improved: When viewing the list of files in G4 LD Utility or Atlas the file list will appear faster. 

3. Feature: Sort feature which allows data in SLM and FFT tabular data view to be sorted by right-

clicking the desired column and selecting 'Sort Descending' or 'Sort Ascending'. The data on the 

following SLM and FFT tabs can be sorted: Statistics, Event History, Measurement History, Time 

History, FFT Overall, FFT Measurement History (Avg), and FFT Measurement History (Max). 

4. Feature: It is now possible to select whether a meter is defined by the meter serial number or 

the IP address using the new "Connection Use" feature when defining a new connection. When 

a meter is defined by the IP Address it is possible to define the meter name in G4 using a site 

name. This provides the ability to swap meters at the site while keeping data from different 

meters associated with the single site 

5. Added: GPS information can be clicked to open a webpage showing the location on a map. 

6. Improved: When taking FFT measurements with an 831C and the Frequency Span divided by the 

Number of Lines (bin resolution) is less than 0.4, the frequency information displayed switches 

to two points of precision. 

7. Improved: When importing Archive folders the files are correctly assigned the model and serial 

number and are placed in the correct folder under the Meters folder instead of the Imported 

folder. Further, when selecting the Export xlxs, json or csv in the Tools>Options these files will 

also be created. 
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8. Fixed: While Pinning the LAF was incorrectly placed between the LASmin and LAFmin. It now 

resides after the LAS. 

9. Fixed: File Save As works for FFT files. 

10. Fixed: On a Spartan file in French, the Audio will pass correctly to the Time History Graph. 

11. Fixed: The Audio Streaming could be affected by network lag and close the stream with an error 

message. 

12. Fixed: When the Grouping option is selected, Edit Bands will correctly recalculate the data on 

the Summary tab. 

13. Fixed: The command-line file export will correctly process Model 831 archive files with sound 

records. The command-line export will correctly handle network file/folder locations. 

14. Fixed: The Import from USB/Open Archive Folder will correctly process files with sound records. 

15. Fixed: When viewing a Spartan 730 file User, Job Description, Location and Notes would not 

transfer between the tabular data view and the report. 

16. Fixed: The User, Job Description, Location and Notes fields were not aligned with the labels in 

the FFT files. 

17. Fixed for 831: A defect that caused some files containing reverberation time or RT60 data to fail 

opening in G4 has been fixed. 

18. Fixed: In an 831C FFT file, the tonality graph view displayed the incorrect number of FFTs in 

Average in the legend when selecting a measurement other than the first. 

19. Improved: When configuring the 831C Time History with a period less than one second, the TMS 

metric is now automatically enabled. 

20. Fixed for 831C: The full screen FFT Live Graph axis units were reported incorrectly when 

Integration was used. When set to use the logarithmic y-axis, if the min value is set to 0 the 

graph will display correctly. 

21. Fixed for 831C: The units on the metric in the file list for SLM files showed incorrect values when 

"Other" transducer had previously been selected. The FFT metric in the file list will be displayed 

with correct units once the file has been downloaded and opened. 

G4 LD Utility Version 4.6.1 March 2021 
1. Fixed: A defect that causes the time history graph in G4 to display incorrect data if Group 

Metrics is selected on the Miscellaneous tab in Options has been fixed.  

2. Fixed: When Group Metrics is selected then the Time History worksheet OBA data column 

names were incorrect. The names have been moved to their correct columns and have been 

updated to "SPL", "Leq", "Lmax" and "Lmin", for both the Full Octave and Third Octave data. 

G4 LD Utility Version 4.6.0 March 2021 
1. Feature: FFT Support on the 831C. 

2. HVM100 will no longer be supported by G4 after this release. 

3. Feature: Export to CSV from File menu, command line or during auto download 

4. Feature: Auto Download can be enabled and disabled from the Meter List context menu. 

5. Feature: HVM200 displays live OBA graph at a rate of once per second for each of the 3 axes. 
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6. Feature HVM200: You can format the user storage Micro SD card in the Meter View -> 

Maintenance tab. 

7. Feature: For 831C, 831 and LxT meters, added new menu items to run, stop, store and reset 

with the representation of the state of the meter. 

8. Feature: Users can open files from their email, like double clicking in outlook. 

9. Feature: If more than one user is talking to an 831-INT-ET G4 allows it to upgrade. During the 

upgrade the other communication is ceased, until the upgrade is complete. 

10. Feature: Addition of Auto Download to HVM200 which also updated the Meter View for the 

HVM200. 

11. Improved: When deleting files you may choose to delete the .xlsx, .csv and .json files. 

12. Improved AudCal: Certificates, for Booth and Audiometers, show failed if the current Test Suite 

has not passed. 

13. Bug Fix: Allow older firmware to open the Meter View and allow the upgrade process for old 

firmware for 831-INT-ET and Model 831 

14. Improved: When a user changes the name of a meter in the meter list, the name is now used in 

the Setup Manager and Auto Download sections. 

15. Improved AudCal: You can create a mastoid without first creating a microphone and coupler. 

16. Updated Spartan: Removed Virtual Dosimeter Detector setting, force to Slow 

17. Fixed: In the Setup Manager on the meter side, sometimes did not show the Active setup after 

transferring to meter. 

18. Improved HVM200: Notify user that the entered sensor information will not be used if the 

sensor has TEDS. 

19. Improved Security: When changing the user password you cannot leave the Confirm Password 

field blank. Pressing "Esc" does not break the password dialog. 

20. Updated: When projects are removed, a popup asks if the user wishes to delete the files as well. 

21. Fixed: On the SoundAdvisor 831C meter UI, the Measurement History tab shows the correct 

information after switching from a file 

22. Fixed: When importing a settings file, the form fields (Threshold/Exposure) did not update if the 

virtual Dosimeter modes changed. 

23. Improved: G4 will restart upon switching languages to load the new language. 

24. Improved: UI Instructs the user to enter mV/m/s2 for the sensitivity on HVM200 sensor. 

25. Fixed: "Save All" button in Audio Player properly saves files for SLM and Spartan meters. 

26. Fixed: In the FFT graphs, fixed issues with Tonality configuration input text boxes. 

27. Improved: In command-line processing mode, if no output file name is specified, the input file's 

name will be used for the output files. 

28. Fixed: If no weather station was detected by the meter, G4 will correctly display the columns 

affected. 

29. Fixed: G4 could crash when auto downloads are enabled and G4 is closed while processing the 

downloaded files from a meter. 

30. Fixed: PTB files will open with this version of G4. 

31. Fixed: (TT 7256) The status will display the correct USB voltage. 

32. Fixed: If there is no motion for an entire measurement, the graph will display the "no motion" 

line, if it exceeds the limit set in G4 Options. 
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33. Fixed: If first time history entry is invalid (like TWA) then the graphs still shows for the history for 

the rest of the valid data. 

G4 LD Utility Version 4.5.2 October 2020 
1. Feature: Addition of Rain and Hail weather data to the Time History spreadsheet for 

SoundAdvisor Model 831C files. 

2. Feature: You may now choose to keep similar metrics in the Time History together and to pin 

the columns so that the data in the columns do not move based on selected metrics in the Time 

History. 

3. Improved: Updated connection functions to allow communication with older firmware. 

4. Improved: Updated the firmware upgrade process to work with older firmware and slower 

connections. 

5. Improved: The meter model name for an LxT SE matches in the Meter List view. 

6. Bug Fix: (tfs10244) Checkboxes show on projects and meters that are displayed when expanding 

projects. 

7. Bug Fix: AudCal Sync works with spaces in the file path for backups. 

8. Bug Fix: Meters with Nicknames containing invalid characters are cleaned so that they show up 

in the Meter List. 

9. Bug Fix: Able to recognize old firmware on 831-INT-ET allowing user to select the upgrade 831-

INT-ET firmware from the context menu. 

10. Bug Fix: AudCal signatures are validated before storing and retrieval to ensure user can continue 

to use the report and certificate options. 

11. Bug Fix: Spartan live view values truncated to whole numbers when PC language set to a 

language where a comma is used as the decimal separator. 

12. Bug Fix: Changes made to the Calibrators on the Calibration Settings page will now update the 

main Calibration page. 

13. Bug Fix: Spartan Time History graph now shows the Motion and No-Motion bands when viewing 

files with 60 second histories. 

14. Bug Fix: Reduced the time it takes to open sound level meter files with Time History by 7%. 

G4 LD Utility Version 4.5.1 August 2020 
1. Feature: Project folders may be sorted and moved. Pressing "Shift" while dragging a project will 

allow you to drop the project inside another project. You may add Projects to other Projects. 

2. Improvement: When a project or meter is renamed, the search feature will now update existing 

files so they are found under the new name. For example, if I have a project named "Test" that 

contains 3 files and then rename the project as "NewTest" and then search for files in the 

project "NewTest" it will find the 3 files that were previously in the project "Test”. 

3. Bug Fix: When playing a sound record from a Spartan file, "Save All" will allow you to save all of 

the Sound Records from that file. 

4. Bug Fix: We have fixed G4 so that DNA can again connect to meters.  

5. Bug Fix: Setup Manager configuration list will scroll with arrow keys. 
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6. Bug Fix: AudCal reports and certificates generation has been fixed. Also the pdf's support 

different language fonts. 

7. Bug Fix: In Setup Manager on an HVM200 if you navigate through the time page after making 

changes the meter did not let you cancel. The cancel works correctly with this release. 

8. Bug Fix: An issue where an 831C spreadsheet did not save the User, Job Description Location or 

Notes has been fixed. 

9. Bug Fix: Auto-download and downloads would create a file with 20 Bytes even if the file no 

longer existed on the meter, failed to download or communication was lost. 

10. Bug Fix: Push Settings to multiple meters did not push Event Trigger settings to the meters. Now 

all of the settings are pushed to each selected meter. 

11. Bug Fix: Auto-downloads for Spartans did not always recognize new files unless the meter tab 

was opened in G4. G4 now finds new files generated on the meter and auto-downloads them if 

configured to do so. 

G4 LD Utility Version 4.5.0 May 2020 
1. Feature: Scheduling and Accounts have been added to the 831C. G4 allows you to interact with 

these features. 

2. Feature: G4 can communicate over a secure connection with the 831C. 

3. Feature: G4 can now Auto-Download files from all SLM meters 

4. Feature: Improved Dropbox authorization to use the Larson Davis G4 Dropbox and uses a folder 

specific to G4. Included update uses localization of the interface. 

5. Feature: The File Manager for all SLMs has been improved to allow searching of files based on 

name, serial number, and general info. Further, Projects and Meters may be opened to browse 

and search all files associated with these. Clicking on the item in the device panel will open this 

new view.  

The file list now has more columns that provide specific information about the file which can be 

sorted. The list also loads faster from and is more responsive. When files are deleted from local 

the xlsx is also removed. Right-click in file list allows you to open the file location in the windows 

explorer. With Open on Download and Export to .xlsx checkboxes to help organize your data 

when downloading. 

The file manager allows for downloads to be cancelled and resumed 

6. Feature: Projects now contain the folders of the meters that it contains and thus the files 

downloaded from a meter in the project will also be stored in that project's sub folder. When 

renaming projects G4 will try to move the files to follow the new project name. 

7. Feature: More spreadsheets, graphs and data has been localized into more languages and 

current languages have been expanded. 

8. Feature: You may now upgrade multiple 831C meters simultaneously 

9. Feature: New general help page for new and updated features 

10. Feature: Ability to push Measurement and System settings to multiple meters simultaneously 

11. Feature: Settings have been separated based on meter. Previously all of the settings resided in 

the same location and thus a Default settings for 831C, 831, LxT and LxT SE were all the same 
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even though each meter had some minor differences. Now the Default settings will be specific 

to each meter. 

12. Feature: You may specify your "Default Path" for storing files for all meter types. Further, 

Downloaded and Imported files are now saved to a folder structure that mirrors the assignment 

of meters to Projects in the left pane of G4. Files will be stored as follows: 
a. File path for meters in the Meters section of the G4 left pane: 

b. DefaultPath\Meters\MeterName\model_serialNumber-startTime-meterFileName.extension 

c. File path for meters under a Project of the G4 left pane: 

d. DefaultPath \Projects\ProjectName\MeterName\ model_serialNumber-startTime-

meterFileName.extension 

1. Not user settable 
2. User may set project and meter names 
3. File names are generated automatically, not user settable 
4. DefaultPath – Documents\PCB Piezotronics\G4 or as configured by user in G4 Options, File 

Options  

 

e. Storing the files this way permits fast and flexible file searching and better tracking 

whether files have been previously downloaded, so they won't be downloaded again 

every time they are opened. 

13. Feature: The "Download Options, Download to Subfolder" checkbox has been removed. The "G4 

Options, File Options" tab provides for setting the default location for downloading files. To 

support new features, such as File Search, the organization of the files at the user specified 

default path should not be modified or customized. 

14. Feature: Spartan Files improved the Pre and Post Calibration information to include the 

Deviation and Calibration Level. Also added Overload Count and Duration to the files. 

15. Feature: Update Help Menu to separate the Release History from the Manuals 

16. Feature: For the 831C, improved the order of the data included in the spreadsheet for Event 

History and Event Time History with the new weather and all the weighted level data. 

17. Feature: Edit Band modification time stamp arrows move the time faster the longer they are 

depressed, allowing for faster navigation when using edit bands. 

18. Feature: Removed HVM Licensing; no license is required for accessing the data from HVMs 

19. Feature: Updated AudCal audiometer frequency selection to be based on transducer type 

20. Bug Fix: Audio Streaming no longer has audio pop at the beginning of the stream 

21. Bug Fix: Accidental Drag and Drop in the device panel has been fixed when trying to just select a 

meter 

22. Bug Fix: Edit Band calculations were not always recalculated if only offset changed. Allow edit 

band edge to start at the beginning of the file. 

23. Bug Fix: G4 can now translate HVM200 and Spartan files with more than 1 million Time History 

records 

24. Bug Fix: If a file does not translate, and the error given "Array dimensions exceeded …" or 

"Arithmetic error", G4 will translate as much of the file as possible. 

25. Bug Fix: Removing a project could cause other projects from not allowing meters to be moved to 

them. You may now move meters to the new folders. 



G4 LD Utility Release History 

 

3425 Walden Avenue, Depew, NY 14043, USA  +1 716 926 8243 © Copyright 2014-2022 Page 30 
 

26. Bug Fix: AudCal the auto sync would turn on by closing the popup regardless of choice 

27. Bug Fix: AudCal after upgrade of 831C and G4 did not always sync the AudCal database 

afterward, now you can sync the databases correctly 

28. Bug Fix: G4 will correctly translate files that have been downloaded using other software that 

names the files as slmdl files. Tonality is calculated correctly for FFT files named with slmdl. 

29. Bug Fix: Translation of SLM files continues even if audio may be missing from the file because of 

meter being disconnected before file is fully downloaded 

30. Bug Fix: With certain settings where TMS and OBA are logged in Time History, the translation 

and/or graph would not complete 

31. Bug Fix: Spartan files got saved with every zoom; now only saves upon request 

32. Bug Fix: Spartan Report did not show ISO mode data. Also the spreadsheet labelled a line as 

"LCpeak" but the weighting should be on a per virtual dosimeter basis was fixed. 

33. Bug Fix: Opening a meter before G4 had gotten status would mean that the HLD version was not 

known, so Setup Manager would not work 

34. Bug Fix: Command Line Export uses correct numbering for audio files. Also allows for archives 

files when input specifies only a folder containing multiple archive folders. 

35. Bug Fix: Generated, temporary files are no longer stored next to a file that is opened. Ex. G4 

would leave temporary files on the desktop if the file opened was on the desktop. 

36. Bug Fix: Deleting HVM200 files that showed error when it should not have shown error 

37. Bug Fix: For Spartan merged files stop record not showing with time history 

38. Known: 831C SN: 10123 will not auto download. 

39. Known Issue: If you experience issues with Spartan 730 meters not connecting over USB on 

Windows 10 you may need to update the USB driver to work correctly. 

G4 LD Utility Version 4.0.8 January 2020 
• Bug Fix: When using a graph to create an edit band, a bug that could cause the start and end 

time of the edit band to be up to two samples different from the data used to compute the 

change has been fixed. The start and end times shown on the graph now match the times used 

to compute modified data exactly. 

• Bug Fix affecting 831C: A bug that can cause a meter to appear in the meter list multiple times 

has been fixed and each meter now shows only once. 

• Improvement: If an error occurred on obtaining tonality information from an FFT file G4 did not 

display any information. A message has been added. 

• Improvement: When renaming a meter in the meter list by using the "rename meter" function, 

the edit dialog is now shows the previous name for editing rather than "edit name”. 

• Improvement: The Command-line processing has improved logging, including any unrecognized 

parameters. 

• Bug Fix affecting 831C: A bug that could cause the live display to have a gray overlay and then 

not accept inputs has been fixed. 



G4 LD Utility Release History 

 

3425 Walden Avenue, Depew, NY 14043, USA  +1 716 926 8243 © Copyright 2014-2022 Page 31 
 

• New Feature: When viewing the live data for a Spartan 730 noise dosimeter, a live Leq graph is 

now available. 

• Bug Fix affecting 831 and 831C: When the time history sample period is greater than once per 

second and events are automatically marked in the G4 graph it was possible for an event to 

begin and end during a single time history sample, which resulted in the start and end times of 

the exclusion band not being correctly set. This has been fixed so the start of the exclusion band 

will be the time history sample including the start of the event and the end of the exclusion 

band will be the sample containing the end of the event. 

G4 LD Utility Version 4.0.7 December 2019 

• Bug Fix: Updated installer to properly add drivers to 32-bit machines. 

• Bug Fix: Closing the Calibration popup using the "x" would leave the meter in a locked state. 

G4 LD Utility Version 4.0.6 November 2019 

• Feature: You can set the y-Axis extremes on the Time History SPL/LEQ graph. 

• Bug Fix: Sometimes the dates on the control would change to a wrong date after selecting the 

desired date. This includes the fix for the Time Zone offset causing the day to appear to be the 

previous day when in the Eastern Hemisphere. 

• Bug Fix: The Event Triggers would not appear on the Measurement Properties popup menu 

when on the Setup Manager Tab. 

• Bug Fix: RClone would not authorize or would crash G4. 

• Bug Fix: AudCal failed to sync the meter's database with the G4 database. 

• Bug Fix: HVM license manager popup incorrectly when trying to use G4 with SLMs. 

• Bug Fix: AudCal could force the manufacturer to appear as Larson Davis. 

• Bug Fix: The Locked Screen with the Big Digit display would show the incorrect label. 

• Bug Fix: Opening a meter while Setup Manager is already in System Properties would cause a 

looping reload cycle. 

• Bug Fix: HVM100 connection dialog now shows the serial connection panel. 

• Bug Fix: Missing Manuals from the Help menu. 

G4 LD Utility Version 4.0.5.1 October 2019 

• Bug Fix: The SLM time history charts would not finish processing if the Weather-INT was enabled 

in the file. The charts will finish and display. 

• Bug Fix: Hyphens in the meter's address will now work correctly allowing G4 to access the meter 

and display correctly in the device panel. 

• Bug Fix: Opening a file outside of the meter's folder will now allow you to email the report and 

file. 

• Some third-party security software on your desktop could put tracking files into archive files 

breaking the file structure for the SLM files. The files are now ignored by G4 when importing the 

archives (.s folders). 
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• Feature: Low Frequency L(20-200Hz) added to the 1/3 Octave section on the OBA tab in the 

spreadsheet 

G4 LD Utility Version 4.0.5 September 2019 

• Bug Fix: Spartan File Merge works again as it wouldn't run in the previous release 

• Bug Fix: Spartan files sometimes could contain bumps that would have multiple exclusion bands 

created for them. G4 now creates the bands correctly and only allows a single band that is wide 

enough to be selected. 

• Bug Fix: Edit bands now show the same information as the highlights in the Time History tab in 

the spreadsheet 

• Feature: Feature: Setup Manager menu item added to the file menu so that setups can be 

edited when there has never been a connection to a sound level meter 

• Feature: AudCal now allows users to use non Larson Davis artificial mastoids 

• Bug Fix: When opening the AudCal View from the File menu, G4 seemed to hang, now the view 

opens correctly 

• Bug Fix: Setup Manager settings on 831A would not display  

• Bug Fix: The Save All sound records feature in the Session Log crashed G4 

• Bug Fix: Measurement History Alert configuration is now retained in the Settings 

• Bug Fix: An error that would occasionally occur when transferring properties from a PC to a 

meter has now been fixed 

G4 LD Utility Version 4.0.4  August 2019  
• Bug Fix: The authorization of the Push Feature using rClone would fail, crashing G4. The 

authorization works correctly and G4 no longer crashes due to the issue with rClone.  

G4 LD Utility Version 4.0.3 August 2019 

• Feature: Added configurable trigger source and level to Measurement History Interval email and 

text alerts, updating the property Control tab to allow users to select these options 

• Feature: Added pause, run, and reset to list of conditions that will trigger state transition email 

and text alerts 

• Bug Fix: Fixed issue where date filenames restart at sequence number 0 after reboot or when 

files have been removed (i.e., moved to Dropbox). Now the sequence number will only reset to 

0 at the beginning of a day 

• Feature: Added 1, 2, and 5 minute Daily Auto Store periods and changed user interface to show 

interval time rather than files per day.  

• Spartan 730 Dosimeter Update: In the Settings the grey color denoting inactive or unavailable 

settings is now more noticeable. The Threshold Enabled is disabled in ISO mode. 

• Bug Fix: G4 would hang sometimes when switching between 831C and Spartan tabs 
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• Bug Fix 831C: When there are more than 500 files on the meter, G4 will display the files in pages 

with up to 500 files per page. Deleting all files on the last page no longer causes the Pagination 

to disappear 

G4 LD Utility Version 4.0.1 July 2019 

• Spartan 730 Dosimeter Feature: You have the option to set an administrator passcode that, 

when set, allows users to access settings, system tools, or delete files, only after providing the 

passcode. The passcode is enforced only when using a Bluetooth connection and not when 

connected via USB. 

• Bug Fix: Previously, system properties may be corrupted when transferring between other 

831Cs or G4 LD Utility software with different software or firmware versions. Now, differences 

between versions are handled correctly. If concerned about possible corruption, use G4 LD 

Utility V4.0.1 or later to resend system properties to the meter. 

• Bug Fix affecting 831 & 831C: Weather data displaying dashes when the value is 0.0 has been 

fixed and 0.0 is correctly displayed. 

• Bug Fix affecting 831 & 831C: Wind compass direction would display as dashes if the direction is 

between 350 and 359 degrees. Now, correct direction is shown for all cases except when 

direction is due north (0 degrees), which still shows dashes. 

• Modification and Bug Fix: The menu item, located at File >> Save Edit Band Data has been 

changed to Save SLM File. The menu item did not actually save the file, resulting in a prompt to 

save when the file was closed. 

• Bug Fix: When authorizing the meter to use DropBox, G4 would lock up. This now works 

correctly. 

• Bug Fix: Previously, the edit band shown in the G4 Time History tab (used for calculating the 

modified data) was late by one time history sample. Edit bands are now shown correctly in the 

tab.  

• Bug Fix: When upgrading firmware, the default folder for the firmware file remains consistent 

and works as expected. (7400) 

• Bug Fix: When an SLM has more than 500 files, data files displayed in the Data Manager tab are 

correctly sorted from newest to oldest according to the start time. You don't have to go to the 

last tab in order to see the newest files. 

• Improvement affecting Spartan 730 Dosimeter: The Live View navigation bar remains at the top 

of the window when scrolling down, instead of scrolling off the top. 

• Bug Fix affecting Spartan 730 Dosimeter: Previously, edit bands created automatically due to a 

"bump" created 2 exclusion bands for each bump. Now, each "bump" creates 1 "exclude" edit 

band.  
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G4 LD Utility Version 4.0.0 June 2019 

• New connection device panel provides direct access to all meters with a single click 

• Support for the new Spartan 730 noise dosimeter 

• Support for Projects, the ability to organize meters into user created projects 

• Made upgrading meters easier by meter specific context menu from the device panel 

• Setup manager updated to reduce the loading time 

• Push settings to all connected Spartan meters 

• Improved communication with HVM200 and 831C meters to allow quicker connection 

• Improved the graphs for sound level meters, with the legend set to the bottom with values, edit 

bands, and data corrections updated modified data, unused menu options removed, and only 

open graph if valid time history exists  

• G4 no longer supports connections to meters via analog modems or serial connections, with 

the exception of the serial connection for HVM100 meters 

• HVM100 connection panel updated and moved to Tools menu 

• Known Issue: The auto-merge for HVM100 has been disabled. 

• Bug Fix: Spreadsheet Measurement History records were highlighted red when no overloads 

occurred 

• Bug Fix: Setup manager file list did not update after "format internal" (6407) 

• Bug Fix: 831C Setup manager didn't match the duration of the meter 

• Bug Fix: Cannot Play Voice Recordings is session log (7187) 

• Bug Fix: Gears did not go away after downloading a file with no Time History from 831A (7188) 

• Bug Fix: HVM100: HVM disconnects when run started if HVM is overloaded. G4 can crashes after 

disconnect (7131) 

• Bug Fix: Sync PC and Meter Clocks on maintenance tab does not work with 831C (7010) 

• Bug Fix: On the meter the adjust graph is not available (grayed) when looking at the spectral Ln's 

on the overall tab (5105) 

G4 LD Utility Version 3.3.1 April 2019 

• Bug Fix: Fixed issue in SLM Measurement History spreadsheet where LNs values were not 

displayed correctly. 

• AudCal: The variance in frequencies used during Distortion, Frequency, Hearing Level and 

Narrow Band Noise tests tightened to make the auto switching not use the previous frequency; 

this is usually seen with 1500 and 1600 Hz.  

• AudCal: For Distortion, Frequency, Hearing Level, FM and Narrow Band Noise tests, we 

increased the time for failure before moving to the next step. 

G4 LD Utility Version 3.3.0 January 2019 

• Updates to support new PTB certification 

• Update to the command line feature to allow for archive files received from the 831C Automatic 

Push to be processed to JSON/XML/XLSX 
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• The settings for OBA and Sound range now show the range in dBA as well as the Normal and 

High selection 

• Updated the graphs for 831C, 831 and LxT to work with older and broader range of systems, 

specifically systems that support WebGL1 but not WebGL2. 

• Fixed Edit Bands edge adjusters for 831C, 831 and LxT graphs so that right edge arrows no 

longer update left edge text 

• Updated firmware upgrade to reboot before starting the upgrade to improve the success of the 

upgrade process. Also allow multiple meters to be upgraded at the same time. 

• Known Issue: In the Measurement History of the spreadsheet the first column may be marked in 

red if an overload occurred in any of the histories. The column background red color may 

disappear when scrolling in the spreadsheet. 

• Bug Fix: Correctly adjust for the expected frequency response curve from the data input from a 

certificate of the AEC304 coupler 

• Bug Fix: G4 would fail to apply an Edit Band offset with non-numeric data (i.e. Gust Direction) 

• Bug Fix: The Stop When Stable Run Mode would not use the time that was entered in the 

Control measurement properties 

• Fix for no sound Time History Records in data file so that graph is not displayed (6589) 

• Fixed the recalculation of the Summary to stop errors when no edit band is found 

• Saving files will check for a valid path before trying to save just in case the path has been 

removed. If saving to removable media, each save will check for the media instead of failing to 

save to the removed media. 

• Feature: Added logic to handle .s archives with names that are too long by asking the user 

rename them so they may be processed 

• Bug Fix: Modified logic to allow users to import .s archives from the root of a drive or from the 

second level of the file system 

• Bug Fix: crash when Exporting of HVM files to spreadsheet and printing HVM reports 

• When using G4 to graphically edit HVM data taken for a whole body measurement, the modified 

summation values for the A(8) Act and A(8) Exp are now correctly computed 

• User can now store samples of the Running Leq in time history 

• If a setup configuration did not have the new trigger settings, Events would not trigger correctly. 

The setup files are updated when they used in G4 or on the meter. 

• Changed AudCal narrow-band noise calculation to use FFT instead of octave bands. This allows 

the 831C to correctly determine the narrow band noise levels when the noise bandwidth does 

not match 1/3 octave filter bandwidths. Added the level to the AudCal page on the meter and 

augmented the data displayed on the test page to include the band edge frequencies. 

• AudCal now restricts the bone vibrator to a frequency range of 250Hz to 8kHz, supra-aural and 

inserts are restricted to 125Hz to 8kHz and circum-aural and speakers range from 125Hz to 

20KHz.  

• When closing files a single check is made for modifications and a dialog will ask if the file should 

be saved. Improved the saving of files when changes are made. 
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• Fixed AudCal to allow high frequencies in all tests. In Hearing Level and Narrow Band Noise tests 

valid Hearing levels will need to be entered for the high frequencies. 

• Fix crash when Calibrating a Model 831A meter 

• Bug Fix: (TT 6901) G4 no longer crashes when using "Save All" on sound recordings in the file 

view 

• Bug Fix: (6591) Change masked options without reboot and data not stored, then change a 

property with Reset Required will cause the user interface to lockup 

• Bug Fix: (6517) Fix for Daily Timer Start Time 3 input so that it is not over written by End Time 

• Bug Fix: (6515) Graphing: The Data Legend Marker needs to display when clicking on graph 

• Bug Fix: (6594) 831C UI: Auto store set to Prompt causes 2 prompts to be seen when stop is 

pressed 

• Bug Fix: (6598) HVM200 – Sometimes in Live View the settings page is invisible 

• AudCal: Fix for the Certificate generation for Booth Tests when missing equipment 

• AudCal: Fixed Report generation of the Hearing Level test when using high frequencies 

• AudCal: Fix for "Set Levels" for the Narrow Band Noise and the Hearing Level tests to allow non-

standard frequencies including high frequencies  

• AudCal: (6267) Fixed the FFT zoom when accessing the Live View in G4 or on a tablet  

• Bug Fix: (TT 6976) Fixed the selection of a Measurement or Event to be persistent when more 

than one exists while accessing the Live View in G4 or on a tablet  

G4 LD Utility Version 3.2.1 September 2018 

• Addition of the Time History graphs for LxT, Model 831 and SoundAdvisor 

o Zoom and panning of the time history data  

o Report generated for printing and in pdf form with overall summary and graphs 

o OBA spectrograms align with the level line graphs 

o Playback of audio denoted in the graphs including continuous audio 

▪ The audio playback and the audio graph marker could be off by up to one 

second, due to sound recording timestamp resolution. 

o Events marked on the graph including the ability to playback associated audio records 

o Editing of the time history using edit bands, with offsets and exclusions 

• When zoomed, the graphs may not line up completely. 

• Added the ability to set static IP address on 831C 

• Updated Event Triggers to work with new functions on the 831C 

• Added Running Leq setting 

• The folders for saving are tracked for user 

• Audiometric Calibration reports improved and their generation sped up 

• AudCal right-click menu on the tree to allow adding and removing of items 

• Fix bug with the RETSPL's not storing for high frequencies 

• Update for non-meters appearing in the list of USB devices 

• Changing the language in G4 updates the meter directly 
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• Updates to the Light and Dark themes to improve legibility 

• Connection table no longer looks for duplicate meters or combines names of duplicate meters 

• Added "Export to JSON/XML" functionality (also available from command line) 

G4 LD Utility Version 3.10 April 2018 

• Audiometric Calibration (AudCal) functionality added to G4  

• The UI has been improved for the Import Files from USB Drive 

• The Audio Streaming UI is reset when streaming is stopped when changing tabs 

• Updates to the Meter Catalog that will back up the catalog and reduce the number of writes to 

reduce the chance that catalog entries are lost 

• Fixed potential crash from bad or unstable TCPIP communication 

• Settings and Property files will transfer correctly between PC and Meter 

• When using Set to Active the meter sometimes loaded the wrong setup 

• Cal Check can be run from G4 and improved responsiveness to the Calibration pages, also 

updates to the Certification Reminders were not working. 

• Time History OBA Overload column only in export if Time History OBA metrics were selected 

• Added command line parameters to process a .ldbin file or all .ldbin files in a folder to create 

.xlsx files 

• Fix for dpi issue causing the Meter View to not display properly in some configurations 

• Added System Metrics for the 831C on the spreadsheet summary tab 

• Updates to audio playback and audio streaming, including potential crash bug fix 

• HLD on the meter was crashing when connecting from G4 

• Fixed issue with removing setup files where they would not always be removed 

• Improved the resolution of many of the icons in menus 

• Fixed weather page that had trouble with switching units between degrees and compass, and 

missing Temperature 

G4 LD Utility Version 3.06  November 2017 

• Firmware upgrade process to protect against downgrading to prior than 3.06 to prevent errors 

reading/writing newer flash chips 

G4 LD Utility Version 3.05  October 2017 

• Fix for Model 831 and SoundAdvisor Time History TMS showing in the wrong column, and 

weather data with correct units 

• Units on OBA are now correct when using integration with HVM200 

• Added Portuguese (BR) to G4 language selection menu. 

• Updated current languages with missing strings 

• Fixed crash when playing audio files in G4 

• Fixed ScreenGrabber so that a momentary loss of connection no longer stalls screen updates 
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G4 LD Utility Version 3.04  June 2017 

• Allow users to configure the SoundAdvisor Model 831C to use SFTP or Dropbox for cloud 

storage. Files are transferred after they are stored on the 831C. 

• New "Open .s Folder" option, to allow users to open files from Dropbox or SFTP 

• Updated lock/unlock feature to ensure a code is entered for Model 831 

• Added more parameters like epoch time for audio file command line export also improved 

documentation 

• Fixed meter connection issue where name on tab was incorrect. (5667) 

• Removal of temporary files on installation (5666) 

• Added HVM200 annotations in spreadsheet export. They are found in the Notes field and in a 

column in the time history tied to the time at which they were entered. Updated the column 

width for the summary. 

• Fixed the "Restore Defaults" function on the Tools->Options->File Options tab so that the 

correct defaults are restored 

• Initial default for downloading files will open the file in G4 (5386) 

• Fixed the gust and wind direction column on Measurement History spreadsheet to display the 

correct directions if units are set to compass, e.g., N, NE or S (5362) 

• Fixed issue where Live View would not update when meter would turn off backlight 

G4 LD Utility Version 3.03  May 2017 

• Fixed Time History and Event Time History spreadsheet to properly display all values when a 

comma decimal separator is used as part of the Culture Info 

• Updated Audio Streaming to work if a password exists on the Model 831A meter 

• Added capability to slide the Status display off to the right and back again 

• Improved the 831-INT-ET upgrade process to work with the Sound Advisor and remove the time 

constraint when trying to connect 

• For time history periods greater than 1s previously the meter would report the wind speed and 

direction for the last 1 second sample. Now the meter reports the average over the sample 

period. 

• Fixed issue with Event Time History so that the post trigger is now displayed correctly 

• Added command line operation of G4 to export audio files directly from LDbin files with the use 

of the SDK 

• Added support for NMS044 with a new setup file that will appear at the top of PC list 

• Installation will notify you when Administrative privileges are needed and cause installed files to 

be accessible with any standard user 

• Fixed crash bug with older versions of 831-INT-ET firmware 

• When using WiFi in G4, the password is now correctly saved, allowing connection over WiFi 

• Added the Time Zone property to the Set Time dialog from the Meter Manager Maintenance tab 
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G4 LD Utility Version 3.02  April 2017 

• Release in conjunction with new firmware for 831C 

• Improvement of the HVM200 firmware upgrade process 

G4 LD Utility Version 3.00  March 2017 

• Provide connection and tools to work with SoundAdvisor™ Model 831C (831C) 

• Improved Setup Manager to work better with all meters 

• Update Audio Streaming to also include Compression on 831C 

• Improved connection status with meters 

• Fixed issue with file translation and GPS data with no sync, and Measurement Histories. 

• Further improvements to the Spreadsheet Views 

• Updated connection dialog 

• Improved time sync with meters 

• Improved messaging when G4 is minimized or not visible 

• Fixed a few issues related to culture variants 

• Audio Playback in Live View for 831C 

• Upgrade process for 831C 

• Allows meters to display language of G4 not the meter. 

• Fix for Store command 

• File Listing in Meter Data View shows data completely and display USB icons for files on 831C 

• Improved audio normalization 

• Fixed issues for Calibration Histories for LxT1 and other meters. 

• Minor UI fixes to Live View 

• G4 sizing is now stored between sessions 

• Drag and drop files onto G4 to open 

• Fixed Time History display of LAeq to show more decimals of precision (4438) 

G4 LD Utility Version 2.2.1  December 2016 

• Fixed the password issue that blocked transferring of setup files 

• Fixed issue with playback of Sound Records 

G4 LD Utility Version 2.2.0  November 2016 

• New Light Theme available from the Option Miscellaneous tab 

• Fix for FFT tonality crash when graphing tones 

• Improved download reliability, especially on bad connections 

• Connections dialog modified to ensure multiple connections to same meter cannot occur 

• Fixed slmdl import, multi-record import, cal/cal check history graph 

• LxT preamp displays correct preamp data 

• Improved Configuration Manager and associated loading 

• Added ability to download to subfolders 
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• Changed status page time to display 24 hour clock 

• Fixed issue with file translations especially in different locales 

• Move Time History "TMS" column immediately after the "Time" column 

• Fixed mislabeled field in Summary spreadsheet tab 

• Improved the playback of sound records in spreadsheet with placement in Measurement 

records and Event History records including scrolled content. 

• Window size of G4 remembered between launches 

• Full time zoom for HVM200 in Live View 

• Improved the spreadsheet translation process 

• Improved UI experience, removing lag in certain operations 

• Improved communication with HLD including shutdown 

• Update to allow Settings in HVM200 on live view in G4 

• Fix for event history page elements size issue 

G4 LD Utility Version 2.1.0  August 2016 
• Improved playback of voice and sound records (Audio Scaling) 

• Improved file processing with messages, also fixes for .slmdl files (6456, 6535, 6561) 

• Further improvements to printed reports for HVM200 and HVM100 (2803, 3292, 6557) 

• Improved Messaging, Meter Interaction and File Indicators 

• Fixed G4 Maintenance Tab / Set date and time dialog for HVM200 

• When transferring Property files a name may be specified 

• Fix for opening LxT and 831 files from USB, allowing G4 to "Import" USB data files in a more user 

friendly way. Can select files from multiple folders, no extension requirement, and better error 

messages (6544) 

• Added Measurements and Metrics (M&Ms) to the SLM spreadsheet 

• Improved Meter Connection Dialog with filter for TCP and constant updates of meters plugged 

in via USB 

• Improved firmware and option uploader 

• Spanish and Russian initial localizations 

• Data file working indicator 

• Removed crash bug – Cal Histories 

G4 LD Utility Version 2.0.3  June 2016 

•  Removed 2 crash bugs  

G4 LD Utility Version 2.0.1  March 2016 

• Improved playback of voice and sound records including the user interface (6408) 

• Print report for HVM200 and HVM100 improved (6475) 

• Fixed zoom on LiveView (6388) 

• Fixed issue where left-mouse button zoom hits an invisible wall (6494) 
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• Fixed Excel export process (6493) 

• GPS correctly displayed (6300) 

• Warn user about potential device data format when upgrading (6399) 

• Fixed fresh install issue for xlsx 

• Fixed Summary "Sensitivity" formatting 

• Fixed some minor issues with settings for HVM100 and 831a 

• Improved file download 

• Fixed a potential crash on international installations 

G4 LD Utility Version 2.0.0  December 2015 

• Added support for HVM200 and HVM100 

• New graphing for Time History and OBA Heat Maps for HVM  

• Improved connection dialog 

• Single tab for System and Measurement Properties 

• USB 3.0 support 

• Improved File translations 

• Updated the 831-INT-ET firmware to improve communications 

• Fixed some minor errors with downloading from 831-INT-ET 

• Improved Serial communications 

• Fixed issues with Proxy Servers 

• Removed support for Windows ® XP  

SLM Utility-G4 Version 1.1.1 
• Import for LxT_Data files support 

• Fixed some minor errors in File Translation under Measurement History, and Time History 

• Spelling errors in the file translation process 

• Fixed a crash bug due to slow disconnect when closing down a connection 

SLM Utility-G4 Version 1.1.0      January 2015 
• LxT Support 

• Improved spreadsheet load time 

• Added 64-bit version to allow for larger ldbin file sizes 

• Updated Calibration History tab 

• Improved Audio Streaming tab, including Dynamic Range Compression 

• Added Reference Spectra 

• Improved file downloading/opening and messaging 

• Double-click on ldbin file to open in G4 

• For the Main Top tabs: More contrast between background of active and inactive tab and bold 

the title of active tab 

• Added Normalization for playback of session log audio recordings 
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SLM Utility-G4 Version 1.0 

• First Release 

 


